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Windows 10™ 

Desktop Features
Using the Start Menu
The Start Menu screen replaces the Start Screen from Windows 
8. It is a navigation hub for everything you use in Windows 10, 
similar to the Start button in Windows 7. It contains frequently 
used apps, shortcuts to File Explorer and important hubs, as well 
as live tiles that flash to display real time updates. To open the 
Start menu, click the Desktop Start Menu  button or press the 
Windows  key on your keyboard.

Start Menu Shortcuts
You can access important controls from your Start Menu.

•	 Documents: a shortcut to the Documents folder on 
your PC.

•	 Pictures: a shortcut to the Pictures folder on your 
PC.

•	 Settings: your control panel for managing 
how Windows 10 looks and behaves, including 
System, Devices, Phone, Network & Internet, 
Personalization, Apps, Accounts, Time & Language, 
Gaming, Ease of Access, Cortana, Privacy, and 
Update and Security options.

•	 Power: shut down, restart, or put your PC to sleep.

Customizing the Start Menu
•	 To open an app, click the tile.
•	 To view all apps in alphabetical order, use the scroll bar to 

move through the apps.
•	 To turn off live updates, right-click the tile you wish to 

adjust. Select More, and select Turn Live Tile off from the 
resulting menu.

•	 To rearrange the app tiles, click and hold the tile you wish 
to move. When the screen dims, drag the tile to the desired 
location.

•	 To create groups, 
click and drag 
desired apps 
into proximity. 
To name the 
group, click in 
the Name group 
space or click on 
an existing group 
name. Enter the 
name for the 
group in the editing bar that appears. Click outside the bar 
to save the name and return to the Start Menu.

•	 To resize a tile, right click on the app you wish to adjust. 
Select Resize, and select a size from the resulting menu.

•	 To resize the Start Menu, click and drag the corners.
•	 To remove a tile, right click on the app you want to remove. 

Select Unpin from Start from the resulting menu.
•	 To pin an app to the Start Menu, right-click on the app you 

want to pin. Select Pin to Start from the resulting menu.

Getting Started
Windows 10 Desktop

u	 Recycle Bin – contains deleted files.
v	 Start Menu Button – stores all Windows Store apps, 

functions, and personal settings in a central hub.
w	 Cortana – the Microsoft virtual assistant and search feature.
x	 Task View Button – displays active apps or additional 

desktops.
y	 Taskbar – displays shortcuts for File Explorer and Edge as 

well as Office programs and other apps that you pin for easy 
access.

z	 Notification Button – displays the Action Center for your 
notifications and settings.

Unlocking the Lock Screen
The Lock screen contains the time, date, sign-in access, user 
accounts and notifications.
1.	 Press any key to view the Login screen.
2.	 Log in with your account password.
3.	 Optional: To switch between multiple users, select the account 

you would like to log into. 
4.	 Optional: To put your computer to sleep, click the Power  

button and select Sleep.
5.	 Optional: To restart your computer, click the Power  button 

and select Restart.
6.	 Optional: To turn off your computer, click the Power  

button and select Shut down.

Changing Your Lock Screen Picture
1.	 Click the Desktop Start Menu  button.
2.	 Click the Settings  button.
3.	 Click Personalization.
4.	 Click Lock screen in the left pane.
5.	 Click the arrow on the Background box and select an option 

from the resulting menu. You may have to select a picture 
depending on the option you select.

Microsoft®
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Desktop & Personalizing

Personalizing
Changing Your Desktop 
Background
1.	 Click the Desktop Start Menu  

button.
2.	 Click the Settings  button.
3.	 Click the Personalization  

shortcut.
4.	 Select a background from the 

Choose your picture options 
or click the Browse button 
to use one of your personal 
pictures.

5.	 Optional: To change the fit of 
the image you have chosen, 
click the arrow on the Fill box 
in the Choose a fit section 
and select an option from the 
resulting menu.

6.	 Optional: To change your 
background to a sold color, 
click the arrow on the Picture 
box in the Background 
section. Select Solid color.

Note: You can change your 
background to a slideshow of 
your images by clicking the arrow on the Picture box in the 
Background section. Select Slideshow from the resulting menu.

Changing the Color Scheme
1.	 Click the Desktop Start Menu  button.
2.	 Click the Settings  button.
3.	 Click the Personalization  shortcut.
4.	 Select Colors in the left pane.
5.	 Choose a color from the palette.
6.	 Optional: To automatically match your Start Menu color to 

your background, check the Automatically pick an accent 
color from my background box.

Applying a Screen Saver
1.	 Click the Desktop Start Menu  button.
2.	 Click the Settings  button.
3.	 Click the Personalization  shortcut.
4.	 Select Lock screen in the left pane.
5.	 Scroll down and click the Screen saver settings shortcut.
6.	 Click the arrow on the box under Screen saver and select a 

screen saver from the resulting menu.
7.	 Select the amount of time for the computer to be idle before 

the screen saver will start in the Wait box. 
8.	 Optional: To customize screen saver settings, click the 

Settings button.
9.	 Optional: Check the On resume, display logon screen box.
10.	Click the OK button.

Applying a Theme
1.	 Click the Desktop Start Menu  button.
2.	 Click the Settings  button.
3.	 Click the Personalization  shortcut.
4.	 Select Themes in the left pane.
5.	 Select a theme in the Apply a theme section.
6.	 Optional: You can also click the Get more themes in Microsoft 

Store shortcut to choose an additional theme.

Using Task View
You can view and switch between open apps by entering the Task 
View. You can also create additional desktops to better organize 
your workspace. Click the Task View  button on your Taskbar 
to access your Task View or press Alt + Tab on your keyboard to 
scroll through your open apps.

Creating a Second Desktop in Task View
If you are working on multiple projects, you can easily keep 
yourself organized by creating an additional desktop. For example, 
you may want to create a desktop with apps for a work project and 
create a separate desktop for your personal email.
1.	 Click the Task View  button on your Taskbar to access your 

Task View.
2.	 Click the New desktop  button.
3.	 Click in the newly created desktop window and open the apps 

you would like to work with from the Start Menu. (You can 
also drag apps from the Task View into your new desktop.)

4.	 Optional: To return to your previous desktop, click the Task 
View  button again and select your desktop.

5.	 Optional: To close a desktop you are finished using, click 
the Task View  button. Hover your mouse cursor over the 
desktop and click the Close button that appears. 

Note: To switch between different active desktops, press the 
Windows  key + Tab on your keyboard.

Pinning an Item to the Taskbar
You can “pin” an app to your Taskbar for easy access.
1.	 Click the Desktop Start Menu  button to locate the app you 

want to pin.
2.	 Right-click the app you want to pin.
3.	 Select More and select Pin to taskbar from the resulting 

menu.
4.	 Optional: To open the item, touch or click its button on the 

Taskbar.
5.	 Optional: To rearrange how an item appears on the Taskbar, 

touch or click and drag the button to the position you desire.
6.	 Optional: To delete an item from the Taskbar, right-click the 

button for the app and select Unpin from taskbar from the 
resulting menu.

Working with the Action Center
The Action Center replaces the Charms bar as a hub for 
notifications and important settings. To show the Action Center, 
click the Notifications  button on the bottom right corner of 
your screen or press the Windows  key + A on your keyboard. 
From here, click news or notifications to view their content. You 
can also use the Quick Actions to perform basic tasks. 

Using Quick Actions
You can use Quick Actions to perform certain frequent tasks.
1.	 Click the Notification  button to open the Action Center. 

From here you can do one of the following:
•	 To access your settings, click the All settings button.
•	 To connet a new device, click the Connect button.
•	 To enable your location for apps, click the Location button.
•	 To turn on Tablet mode and enable touchscreen options, 

click the Tablet mode button. Apps will appear on a large, 
easy to touch Start Screen. 

•	 To turn on night time lighting, click the Night light button.. 
Note: When certain Quick Action modes are enabled, their 
buttons will turn blue. Click the button again to disable the 
feature.
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File Explorer

File Explorer
File Explorer is your hub for all files, folders, and libraries on your 
PC. To open File Explorer, click the File Explorer  button on 
the Taskbar.

Pinning a Folder to Quick Access
File Explorer in Windows 10 opens by default to the new Quick 
access shortcuts on the Navigation pane. You can pin shortcuts to 
frequently used folders so they are easy to immediatly access.
1.	 From the Desktop, click the File Explorer  button to open 

the File Explorer.
2.	 Navigate to the folder you wish to pin to the Quick access 

section.
3.	 Right-click on the folder and select Pin to Quick access from 

the resulting menu.
4.	 The folder will appear under the Quick access section of the 

Navigation pane.
5.	 Optional: To unpin a folder from Quick access, right-click on 

the folder and select Unpin from Quick access.

Navigating in File Explorer
In File Explorer, you can access almost any item on your computer 
by clicking on a shortcut in the left pane. You can also access your 
OneDrive, This PC hub (which contains Folders and Devices and 
drives), as well as Drives and Network locations.

•	 To navigate to a previously opened folder, click the Back  
or Forward  buttons.

•	 To expand a folder and view the contents, click the Expand 
 button beside the folder name.

•	 To minimize an expanded folder, click the Minimize  
button beside the folder name.

•	 To access tools for common tasks, click the tabs to open the 
Ribbon. 

Changing Your Default Opening Folder
You can go back to opening to My PC as the default hub that File 
Explorer opens to instead of using the Quick access view.
1.	 In File Explorer, click the View tab to open the Ribbon.
2.	 Click the bottom of the Options  button in the Show/hide 

group.
3.	 Select Change folder and search options from the resulting 

menu.
4.	 In the Open File Explorer to space, click the arrow and select 

This PC from the resulting menu.
5.	 Click the OK button when you are finished.

Creating a New Folder
1.	 Open the folder or library where you 

want to create the new folder.
2.	 Click on the Home tab.
3.	 Click the New folder  button in the 

New group.
4.	 Enter a name for the folder and press 

the Enter key.

Renaming a File or Folder
1.	 Select the file or folder you want to rename.
2.	 Click on the Home tab.
3.	 Click the Rename  button in the Organize group.
4.	 Enter a new name for the folder and press the Enter key.

Deleting a File or Folder
1.	 Select the file or folder you want to delete.
2.	 Click on the Home tab.
3.	 Click the Delete  button in the Organize group.
4.	 Click the Yes button to confirm deletion.

Hiding a File or Folder
1.	 Select the file or folder you want to hide.
2.	 Click on the Home tab.
3.	 Click the Properties  button in the Open group.
4.	 Check the Hidden box.
5.	 Click the OK button. (If a dialog box appears, select whether 

you want to apply the change to the folder only or to all files 
and subfolders and click the OK button.)

Sharing a File or Folder
1.	 Select the file or folder you want to share.
2.	 Click on the Share tab.
3.	 Click the Share  button in the Send group and do one of the 

following:
•	 To share with a specific person, click the account name.
•	 To share using a specific service, select the service and follow 

the on-screen instructions.
4.	 Optional: To cease sharing an item you have previously shared, 

click the Remove access  button in the Share with group. 
Click Stop sharing to remove permissions from the file or 
folder. You can also click Change sharing permissions to 
remove or add an individual’s access to the item.

Changing Your File Explorer View
File Explorer can display your files and folders in several layouts.
1.	 Open the file, folder or library you want to change the view for.
2.	 Click on the View tab.
3.	 From here, you can choose one of the following views in the 

Layout group:
•	 To view your items in 

a simple list format, 
select List.

•	 To view your items 
in a list format with 
details such as type and size, select Details.

•	 To view your items as button images, select one of the (Size) 
icon options.

4.	 Optional: To sort the items you are viewing by a particular 
grouping or order, click the Sort by  button in the Current 
view group. Select a grouping from the resulting menu.
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Cortana & OneDrive

Cortana
Cortana is Microsoft’s new digital personal assistant and searching 
function. With Cortana, you can perform actions in Windows 10 by 
voice command. You can tell Cortana important people, places, and 
interests to streamline your commands and get the information that 
is most pertinent to you.

Activating Cortana’s Voice Commands
1.	 On the Desktop, click the Cortana  button in the Type here to 

search bar.
2.	 Click the Settings  button.
3.	 In the Hey Cortana section, click the slider to On. 
4.	 If a Cortana window appears, click the Sure button.
5.	 Optional: To only allow Cortana to respond to your voice, select 

Try to respond only to me. 

Giving Cortana a Command
Cortana can perform almost any function in Windows 10. Some 
common tasks are to search the Internet, create a reminder, take a 
note, ask what music is playing, check the news, or even tell you a 
joke.
1.	 On the Desktop, click in the Type 

here to search bar, or say “Hey 
Cortana” (Unlike other virtual 
assistants, Cortana does not need to 
indicate that she is listening for you 
to speak.)

2.	 Type your question or command in 
the Type here to search bar, or speak 
your prompt to Cortana by voice. For 
example: “Hey Cortana, what’s the 
weather this weekend?”

3.	 Your results will display in the 
Cortana window.

Using the Cortana Organizer
Cortana can help you keep track of your to-do list, send your 
reminders, and even suggest tasks based on things you have 
mentioned.
1.	 On the Desktop, click the Cortana  button in the Type here to 

search bar.
2.	 Click the Notebook  button.
3.	 On the Organizer tab, you can do any of the following:

•	 To view your lists, click the Lists  button. You can also click 
the Add to your To Do list shortcut to add to a list.

•	 To view your reminders, click the Reminders  button. You 
can also click the Create a reminder shortcut to create a new 
reminder.

•	 To view tasks that Cortana suggests for you, click the 
Suggested tasks  button.

Managing Skills with Cortana
Cortana can do a variety of things for you such as play music, keep 
track of your fitness, order food and so much more. 
1.	 On the Desktop, click the Cortana  button in the Type here to 

search box.
2.	 Click the Notebook  button.
3.	 Click on the Manage Skills tab. 
4.	 Click a button that you want to customize and make selections. 

OneDrive
OneDrive is Microsoft’s online cloud 
storage system connected to your 
Microsoft account. You can save different 
types of files and folders in OneDrive and 
access them from any computer or device. 

Navigating in OneDrive
1.	 From the Desktop, click the File Explorer  button to open 

File Explorer.
2.	 On the left pane, click the OneDrive  shortcut to open your 

OneDrive folder.
3.	 From here, you can select one of the following default folders:

•	 Documents
•	 Pictures

4.	 Optional: To create your own custom folder, click on the Home 
tab. Click the New folder  button in the New group.

Adding a File to OneDrive
To make the most of OneDrive, you will need to add your files. You 
can populate your OneDrive through one of the following options:

•	 In the program in which you have created the file, such as 
Word, select OneDrive as the location to save to.

•	 Click the File Explorer  button on your Taskbar or press 
the Windows  key + E to open File Explorer with your 
keyboard. Drag and drop files or folders into OneDrive in the 
Navigation pane.

•	 Right-click the file or folder you wish to add and select Copy. 
Open your OneDrive, right-click again and select Paste.

Using OneDrive Files On-Demand
Files On-Demand allows you to access all of your files in the cloud 
without downloading them and storing them on your device. All 
of your files can be seen in File Explorer and you can open online-
only files from your Desktop or using Windows Store apps.
1.	 From the Desktop, click the File Explorer  button to open 

File Explorer.
2.	 On the left pane, click the OneDrive  shortcut to open your 

OneDrive folder.
3.	 Right-click the file or folder that you want to work with and 

select one of the following options:
•	 View online - This will open the file in OneDrive online.
•	 Always keep on this device - This will download the file 

to your device so that it can be accessed even when you’re 
offline. 

•	 Free up space - This will change the file on an online-only 
file and you will not be able to open this file unless you have 
an internet connection. 

To order call toll-free: 1-800-296-5750
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Microsoft Edge

Microsoft Edge
Micorosft Edge replaces Internet 
Explorer as the new Microsoft web 
browser.

Customizing the Start 
Page
Microsoft Edge opens to the Start 
page by default to display a newsfeed 
of recent news, your weather, and other updates. You can choose 
what information is relevant to you.
1.	 From the Desktop, click the Edge  button on the Taskbar.
2.	 On the Start page, click the Customize  button in the 

upper-right corner of the page.
3.	 Make selection on the Customize page.
4.	 Click the Save button.
Note: To open to a different page than the Start page, click the 
More  button and select Settings. Select an option in the Open 
Microsoft Edge with section.

Browsing in Edge
1.	 From the Desktop, click the Edge  button on the Taskbar.
2.	 Click in the Address bar.
3.	 Do one of the following:

•	 To navigate to a web page, enter the Internet address for the 
page and press the Enter key.

•	 To open a new browsing tab, click the New tab  button 
to open another tab in your browser window. You can also 
right-click on a link in a current window and select Open in 
new tab. (To pull a tab off into a new window, simply click 
and drag the tab away from the tab row.)

•	 To add a current site to your list of Favorites or your 
Reading list, click the Favorite  button.

•	 To return to your last page, click the Back  button.
•	 To skip forward again, click the Forward  button.
•	 To refresh your current page, click the Refresh  button.

Making a Web Note on a Page
You can make a note or draw something on a web page and then 
share it with a contact.
1.	 From the Desktop, click the Edge  button on the Taskbar. 
2.	 Navigate to the web page you want to make a note on.
3.	 Click the Add notes  button.
4.	 From here you can do one of the following actions in the 

Editing bar that appears:
•	 To use the pen tool, click the Pen  button. Right-click 

to select a color or size. Click and drag on the web page to 
draw.

•	 To use the highlighter tool, click the Highlighter  button. 
Right-click to select a color or size. Click and drag on the 
web page to draw

•	 To erase a mark, click the Eraser  button. Click on the 
edit you would like to erase.

•	 To add a comment on the page, click the Add a note  
button.

•	 To copy a part of the page to the Clipboard, click the Clip 
 button. Click and drag on the page to make a selection. 

•	 To remove a note, click the Delete  button.
•	 To save your notes, click the Save Web Note  button. 

Select a location to save the note, and click the Save button.
•	 To share your notes, click the Share Web Note  button. 

5.	 To return to normal browsing, click the Exit  button.

Using InPrivate Browsing
The InPrivate Browsing feature allows you 
to browse the Internet without the web 
history, cookies, or temporary files being 
saved.
1.	 From the Desktop, click the Edge  

button on the Taskbar. 
2.	 Click the More  button.
3.	 Select New InPrivate window.
4.	 Your new window will open. Click the Close  button when 

you are finished or would like to return to normal browsing.

Using the Hub
The Hub is a center for all your stored links.
1.	 From the Desktop, click the Edge  

button on the Taskbar.
2.	 Click the Hub  button.

•	 Favorites: a hub for links you want 
to return to often.

•	 Reading List: a hub for links you 
want to read later.

•	 Books: a hub for books you have 
purchased from the Windows store.

•	 History: a hub for sites you have 
previously visited.

•	 Downloads: a hub for your downloads.
3.	 When you are finished, click the Hub  button again to close 

the Hub.

Using Internet Explorer
You can still access Internet Explorer if you need to open 
something with an alternate browser.
1.	 From the Desktop, click the Edge  button on the Taskbar.
2.	 Click the More  button and select More tools.
3.	 Select Open with Internet Explorer.
4.	 Your new Internet Explorer window will open. Click the Close 

 button when you are finished or would like to return to 
normal browsing.

Switching the Color Theme
You can change the theme of your browser for easier viewing.
1.	 From the Desktop, click the Edge  button on the Taskbar.
2.	 Click the More  button.
3.	 Select Settings.
4.	 Click the arrow on the Choose a theme box and select a theme 

from the resulting menu.

Finding on a Page
You can search on a page for a keyword or phrase.
1.	 From the Desktop, click the Edge  button on the Taskbar.
2.	 Click the More  button.
3.	 Select Find on page.
4.	 Enter the search phrase in the box and press the Enter key.

Using Reading Mode
Reading Mode provides a stripped down, easy-to-read version of 
long articles on the web, free of advertisements or additional links.
1.	 From the Desktop, click the Edge  button on the Taskbar.
2.	 Click the Reading Mode  button.
3.	 Optional: To turn off Reading Mode, click the Reading Mode 

 button again.
Note: If Reading Mode is not available on a particular web page, 
the Reading Mode button will be grayed out.
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Miscellaneous & Functions

Miscellaneous
Multitasking in Windows 10
In Windows 10, you can multitask with several different apps 
or programs at the same time. You can use all of your screen or 
simply snap two apps to either side of your screen and work side 
by side. To snap an app or program to the side of your screen, click 
and drag an app into the corner of the screen and release when the 
guidelines appear. You can also press the Window key and Right, 
Left, Up, or Down arrow keys.

Using Snap Assist
Snap Assist is an easy way to fill up the quadrants of your window 
with open apps to multitask in Windows 10.
1.	 Click the Desktop 

Start Menu  
button. 

2.	 Click on the apps 
you would like to 
open in the Start 
Menu.

3.	 Click on the first 
app you wish to snap 
to a side of your 
screen and drag it 
into place. Release 
the click when the 
guidelines appear.

4.	 Snap Assist will populate the other side of the screen with 
thumbnails of the other apps you have open. Click on one of 
these apps to fill another portion of the screen with that app.

Scheduling Your Updates
In Windows 10, updates occur automatically, but you can choose 
when they occur.
1.	 Click the Desktop Start Menu  button.
2.	 Click the Settings  button.
3.	 Select Update & Security.
4.	 Click the Advanced options shortcut.
5.	 Select options in the Chose when updates are installed 

section.
6.	 Click the Back  button or the Close  button.

Setting Your Privacy Level
You can choose which personal information Windows 10 has 
access to.
1.	 Click the Desktop Start Menu  button.
2.	 Click the Settings  button.
3.	 Select Privacy.
4.	 Click the sliders to turn off options under Change privacy 

options. 

Hiding Cortana
You can remove the Cortana search bar.
1.	 Right-click the Taskbar.
2.	 Select Cortana from the resulting menu.
3.	 Check Hidden.
Note: To restore the search bar, right-click the Taskbar, select 
Cortana, and select Show search box from the resulting menu.

Functions
Restarting or Shutting Down
1.	 Click the Desktop Start Menu  

button.
2.	 Click the Power  button.
3.	 Optional: Select Restart.
4.	 Optional: Select Shut down.

Emptying the Recycle Bin
1.	 From your Desktop, double-click the Recycle Bin  icon.
2.	 Click on the Recycle Bin Tools tab.
3.	 Click the Empty Recycle Bin  button in the Manage group.
4.	 Click the Yes button to confirm deletion.
5.	 Optional: To restore your items from the Recycle Bin and back 

to your folders, click the Restore all items  button.
6.	 Optional: To delete items immediatly instead of storing them 

in your Recycle Bin, click the Recycle Bin properties  
button. Select Don’t move files to the Recycle Bin. Remove 
files immediatly when deleted. Click the OK button.

Signing Out
1.	 Click the Desktop Start Menu  button.
2.	 Click the User  button.
3.	 Select Sign out from the resulting menu.

Working with the User Portal
Your user portal is the hub for your account, where you can 
control sign-in options and user settings.
1.	 Click the Desktop Start Menu  button.
2.	 Click the User  button.
3.	 Select Change account settings.

•	 To add an account picture, 
in the Create your picture 
space click Browse for one 
to select a picture from 
your files or click Camera 
to take a picture.

•	 To change your password, 
click Sign-in options in the 
left pane. Click the Change 
button in the Password section. Follow the instructions to 
verify your new password.

•	 To add another user sign-in, click Family & other users in 
the left pane. Click Add a family member or Add someone 
else to this PC and follow the instructions to add a user.

Windows 10 
Shortcuts
Go to Task view .....................................  Windows + Tab
Go to recent window .............................  Alt + Tab
New desktop .........................................  Windows + Ctrl + D
Switch between desktops ......................  Windows + Ctrl + Arrows
Close desktop .........................................  Windows + Ctrl + F4
Give Cortana a command ......................  Windows + C
Bring up news alerts ..............................  Windows + S


